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PREFACE
The Accela SDK for Windows Store Apps is designed to be easy to install and use. This guide 
walks you through the basics of setting up the development environment and using the SDK or 
project template to create an app.

Revision History
This revision history table summarizes changes made during each release of this document for 
version 3.0 of Accela SDK for Windows 8.

Getting Help
If you need technical assistance, one of your best resources is the Accela Customer Resource 
Center (CRC). There, you can search the knowledge base to find answers to commonly asked 
questions about our products. You can also register to use the Accela Forum where you can 
find a wealth of practical information from other Accela users, as well as participate in dynamic 
information exchange.

If you still have questions after visiting Accela’s CRC site, or if you encounter any problems as 
you use the product, contact your agency administrator. 

If you determine that you need professional technical assistance, have your agency’s 
designated contact call the CRC at (888) 7-ACCELA, ext. 5 or (888) 722-2352 ext. 5. The 
Accela CRC is available Monday through Friday from 6:00 AM to 6:00 PM (PST/PDT)

Before calling, please have the following information available for the CRC representative: 

 The Accela product name and version number.

 Steps to replicate the issue, including any error message or error number.

 Screen shots, if possible.

 Whether the problem is specific to a machine or to a user.

 Exactly when the problem began.

 Anything that changed on your computer or network (for example, new software was 
loaded).

 Table 1: Revision History

Date Description

August 2013 Updated to the latest terminology and user interfaces

May 2013 Initial document release

www.accela.com/support
www.accela.com/support
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 A copy of your configuration file, if appropriate.

Related Publications
Accela provides a set of Accela SDK documents for agency and third-party developers.

 Accela Login Getting Started (online help)

Documentation Feedback
Accela wants to provide you with the most accurate and useful documentation possible. We 
welcome your feedback in helping us improve future versions of this guide. Send an e-mail 
message with your feedback to documentation@accela.com. Please include the product name 
and version number, whether the feedback involves a printed manual or online help, the topic 
title, and a brief description and context of the suggestion.

mailto: documentation@accela.com
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GETTING STARTED WITH ACCELA

SDK FOR WINDOWS 8
Topics

 Preparing Your Environment

 Registering Your Windows Store App on the Accela Developer Portal

 Creating a Windows Store App Using Accela SDK

 Modifying Details about Your App

 Downloading and Running a Sample Project

Preparing Your Environment
The environment where you install and use Accela SDK to create Windows Store apps must 
meet the following requirements:

 Windows 8 operating system

 Microsoft Visual Studio. Choose one of these editions: 

• Visual Studio 2012 Professional

• Visual Studio 2012 Premium

• Visual Studio 2012 Ultimate

• Visual Studio Express 2012 for Windows 8

Contact Accela Customer Resource Center at 1-888-722-2352 ext. 5 for recommended 
environment requirements. Office hours are Monday–Friday 4:00am to 6:00pm Pacific Time. 
You can also contact Accela Customer Resource Center through the Web site at http://
www.accela.com/services/support-login.

Registering Your Windows Store App on the Accela 
Developer Portal

To register your Windows Store app on the Accela Developer Portal

1. Log in to the Accela Developer portal.

2. Navigate to the My Apps tab.

3. Click the Add New App button. 

http://www.accela.com/services/support-login
http://www.accela.com/services/support-login
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The app creation page appears.

4. Complete the required fields.

5. Click the Submit button.

Your application is now registered.

6. Note down your App ID and App Secret as you will need them when setting up the app in 
Visual Studio. 

Creating a Windows Store App Using Accela SDK
After registering your app at the Accela Developer Portal, you have two ways to create a 
Windows Store App. You can create a new project in Visual Studio, install the latest Accela SDK 
that is published to the NuGet Gallery, and then build the app. Or if you have downloaded the 
Accela SDK project templates from the Accela Developer Portal into Visual Studio, you can 
create an app using the template. 

Topics

 Creating an App from Installed Accela SDK

 Creating an App from an Accela SDK Project Template

Creating an App from Installed Accela SDK
Accela publishes all versions of the Accela SDK for Windows Store apps to the NuGet Gallery 
at https://nuget.org/packages/AccelaSDK/. 

To create an app from installed Accela SDK

1. Open Microsoft Visual Studio. 

2. On the File menu, select New and then click Project.

Targeted Users To create an app for agency users, select the Agency App option. 
To create an app for citizen users, select the Citizen App option. 

App Name Enter the app name.

App Description Enter a description of the app.

Stage Select “Under Development” or “Published” from the drop-down 
list. This field defines the app development stage.

App Secret The app secret is generated automatically. Remember the value 
of the app secret and it will be required when setting up your app 
with Accela SDK.

Enabled Mark the check box to enable the app or clear the check box to 
disable the app.

https://nuget.org/packages/AccelaSDK/
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The New Project window appears.

3. In the left pane, click Installed.

4. In the middle pane, select the desired project type such as Blank App, Grid App, or Split 
App. 

5. Complete these fields if necessary. 

6. Click OK.

The new project is created. Now you are ready to install Accela SDK.

7. From the Tools menu, select Library Package Manager and then click Package Manager 
Console.

Name Enter the name of the project, which is also the app name that 
users can see. After the project is created, you can also modify 
the project name. See Modifying Details about Your App on 
page 15 for more information.

Location Use the Browse button to specify where you want to save the 
project files.

Solution name Enter the name of the solution. By default, it is the same with the 
project name.
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The Package Manager Console window appears.

8. Enter the command Install-Package AccelaSDK.

Visual Studio retrieves the latest Accela SDK package from the NuGet Gallery and installs it 
in the project you just created. 

If the Accela SDK is installed successfully, the Package Manager Console window displays 
the messages as follows.
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Meanwhile, the Solution Explorer pod displays the references that Visual Studio has added 
for the installed SDK.

9. In the Solution Explorer pod, double-click the code-behind class file named App.xaml.cs 
and complete the following configuration tasks:

a. In the App class, import the following namespace.

usingAccela.WindowsStoreSDK;

b. In the App class, declare the following variables.

Public AccelaSDK ShareAccelaSDK { get; private set; }

//the App Id & App Secret before registration

private string _appId = "";

private string _appSecret = ""; 
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c. Add the app ID and app secret that you noted down in Registering Your Windows Store 
App on the Accela Developer Portal on page 6 as the values for the _appId and 
_appSecret variables. Here is an example.

private string _appId = "12345678901234567";

private string _appSecret = "a12b34c5d678e9f0ag1h23456ij78kl"; 

d. In the App class constructor, add the following code to the App class.

SharedAccelaSDK = new AccelaSDK(_appId, _appSecret);

After the configuration, the code-behind file now looks like this:

10. Build and run the application as you want.

Creating an App from an Accela SDK Project Template
Accela offers you a set of project templates on the Accela Developer Portal. After downloading 
and installing the template package into Visual Studio, you can brand the templates to create 
your custom A311 app, agency app, or citizen app. The project templates add the necessary 
files and references for the project type, which makes your app development easier.
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Topics

 Downloading and Installing Accela SDK Project Templates

 Using the Project Template to Create an App

Downloading and Installing Accela SDK Project Templates
If this is the first time you create a Windows Store app from an Accela SDK project template, 
follow the instructions in this section to download and install the project templates. If you 
already have the project templates available in Visual Studio, skip this section and see Using 
the Project Template to Create an App on page 12.

To download and install Accela SDK project Templates

1. Navigate to the Resources tab on the Accela Developer Portal.

2. From the Windows 8 Resources list, click the Download Accela SDK for Windows 8 link.

3. Save the template installation package (*.vsix) into your local drive.

4. Locate the template installation package and double-click it.

5. Step through the installation.

Using the Project Template to Create an App

To use the project template to create an app

1. Open Microsoft Visual Studio.

2. On the File menu, select New and then click Project.

Note: You do not need to uninstall the previous version of project 
templates. Running the installation package overwrites previous 
templates in Visual Studio automatically.
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The New Project window appears.

3. In the left pane, navigate to Installed > Templates > Visual C# > Accela. 

The New Project window displays the project templates you have installed.

4. In the middle pane, select the desired project template from which you want to create the 
new app. 

5. Complete these fields if necessary. 

6. Click OK. 

The New Accela App Project window appears.

Name Enter the name of the project, which is also the app name that 
users can see. After the project is created, you can also modify 
the project name. See Modifying Details about Your App on 
page 15 for more information.

Location Use the Browse button to specify where you want to save the 
project files.

Solution name Enter the name of the solution. By default, it is the same with the 
project name.
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7. Enter the app ID and app secret that you noted down in Registering Your Windows Store 
App on the Accela Developer Portal on page 6 and click OK.

The new app is created.

8. If you see a reference error as follows, do the following:

a. On the Build menu, select Configuration Manager.

The Configuration Manager window appears.
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b. Select the specific target platform for your app from the Active solution platform drop-
down list.

9. Build and run the application as you want.

The app may look like this.

Modifying Details about Your App
If necessary, you can modify app information, such as the app name, description, and 
supported rotations. 

To modify details about your app

1. In the Solution Explorer pod, open the package.appxmanifest file.

Note: Do not choose “Any CPU” because it will cause compilation 
errors when you build and run the project.
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The Package.appxmanifest tab appears.

2. Do any of the following:

• To define your app user interface, such as the name of your app, click the Application 
UI tab and modify the fields as needed.
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• To specify the system feature that your app can use, click the Capabilities tab and 
select the capabilities.

3. Run the project to verify the changes you made.

Downloading and Running a Sample Project
Accela offers you a sample project on the Accela Developer Portal. The sample project 
demonstrates the common features that you can integrate into a Window Store app via the 
Accela SDK for Windows 8.

To download and run a sample project

1. Navigate to the Resources tab on the Accela Developer Portal.

2. From the Windows 8 Resources list, click the Download Sample Applications link.
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3. Save the sample project package (*.zip) into your local drive.

4. Open Microsoft Visual Studio and run the sample project.
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